CHAPTER 1. INTRODUCTION
1.0 INTRODUCTION ............................................................................. 1-1
1.1 Identification .......................................................................... 1-1
1.2 System Overview ................................................................... 1-1
1.3 Document Overview .............................................................. 1-3
1.4 Reference Documents ............................................................ 1-4
1.5 Creating a CPM Account ....................................................... 1-5
1.5.1 User Account Management and Privileges ................ 1-6
1.6 Forgot Your Password?.......................................................... 1-8

CHAPTER 2. HOME
2.0 HOME ................................................................................................ 2-1
2.1 Events..................................................................................... 2-1
2.2 Messages ................................................................................ 2-3
2.3 Assignments ........................................................................... 2-6
2.4 My Profile .............................................................................. 2-8
2.5 System Users.......................................................................... 2-8
2.6 Change Password..................................................................... 2-8

CHAPTER 3. DATA
3.0 DATA ................................................................................................ 3-1
3.1 Center Filtering ........................................................................ 3-2

CHAPTER 4. OCCSTDS
4.0 OCCSTDS .......................................................................................... 4-1
4.1 OCCSTD ...................................................................................... 4-1
4.2 Functional Areas .......................................................................... 4-7
4.3 Pay Grade..................................................................................... 4-7

CHAPTER 5. JDTA
5.0 JDTA .................................................................................................. 5-1
5.1 Occupation ................................................................................ 5-5
5.2 Job .................................................................................................... 5-5
5.3 Duty.................................................................................................... 5-6
5.4 Task, Subtask, Step ........................................................................... 5-7
5.5 Adding a New Job, Duty, Task, Subtask or Step............................. 5-11
5.6 Importing CTTL data ...................................................................... 5-20
5.7 Center Filtering ............................................................................. 5-21

CHAPTER 6. PROJECTS
6.0 PROJECTS ........................................................................................ 6-1
6.1 Projects Window ........................................................................ 6-1
6.2 Project Management .................................................................. 6-2
6.2.1 Team Members ........................................................................ 6-3
6.2.2 Assignments ............................................................................. 6-4

Release 5.1
### Table of Contents

6.2.3 TPP and TCCD .......................................................... 6-7
  6.2.3.1 TPP/TCCD Course Information .................. 6-8
  6.2.3.2 Foreword ...................................................... 6-9
  6.2.3.3 Course Overview ......................................... 6-9
  6.2.3.4 Course Status ............................................... 6-9
  6.2.3.5 Development Method................................. 6-10
  6.2.3.6 Trainee Data ............................................... 6-10
  6.2.3.7 Justification ................................................ 6-11
  6.2.3.8 Milestones .................................................. 6-12
  6.2.3.9 Safety Risks and Hazardous Materials ...... 6-12
  6.2.3.10 Course Mission Statement ......................... 6-12
  6.2.3.11 Occupational Classification/Prerequisite ... 6-13
  6.2.3.12 Training Sites ............................................. 6-13

6.3 Curriculum Development ..................................................... 6-14
  6.3.1 Performance Requirements .................................. 6-14
  6.3.2 Curriculum Outline of Instruction (COI) ................. 6-17
    6.3.2.1 Delivery Method ........................................ 6-17
    6.3.2.2 Adding a Module to a Course .................... 6-19
    6.3.2.3 Adding a Lesson to a Module .................... 6-20
    6.3.2.4 Adding a Section to a Lesson..................... 6-23

6.4 Reports ................................................................................. 6-25

CHAPTER 7. REPORTS
7.0 REPORTS .................................................................................. 7-1

CHAPTER 8. RESOURCES
8.0 RESOURCES .................................................................................. 8-1

CHAPTER 9. ADMIN
9.0 ADMIN .......................................................................................... 9-1
  9.0.1 Gatekeeper ............................................................................. 9-1
  9.1 Users .......................................................................................... 9-1
    9.1.1 Active Users ........................................................................ 9-1
    9.1.2 Pending Users ............................................................... 9-3
    9.1.3 Inactive Users ................................................................... 9-3
    9.1.4 Currently Logged in Users ......................................... 9-4
  9.2 Roles .......................................................................................... 9-4
    9.2.1 User Roles ....................................................................... 9-5
    9.2.2 Project Roles ..................................................................... 9-5
  9.3 Centers ................................................................................... 9-6
  9.4 Agencies .................................................................................. 9-7
  9.5 Training Sites .......................................................................... 9-8
  9.6 Training Task Analysis (TTA) Data ...................................... 9-8
  9.7 In-Use ..................................................................................... 9-8
  9.8 Announcements ....................................................................... 9-10
1.0 INTRODUCTION

1.1 IDENTIFICATION

This User’s Manual supports the functional operation of the Content Planning Module (CPM) 5.0 software. The CPM is a key component of the Navy’s Integrated Learning Environment (ILE).

1.2 SYSTEM OVERVIEW

The CPM supports planning and management of content intended for the ILE. Major functions include: development of Job Duty Task Analysis (JDTA) information, building of learning objectives planning, managing and executing of content projects, supporting content development workflow and reporting requirements, data exchange and linking with other systems. In addition the CPM supports Centers in the areas of: event management, messages and announcements. The CPM supports the reuse and repurposing of ILE content by sharing the JDTA items, learning objectives, course outline of instruction and learning object structure entered by Centers and sharing project information. The CPM is designed to support NAVEDTRA 136 and related policy guidance.

The CPM application compliments the current ILE system by:

1. Enabling the connection of learning content to validated requirements.
2. Enabling the building of integrated learning objectives per the ILE guidance.
3. Planning and managing content development projects.
4. Supporting content development workflow and reporting requirements.
5. Supporting data exchange with other systems via Navy owned repositories.

The role the CPM plays in that process as depicted in Figure 1-1.
The Navy captures requirements as JDTA items and associated Knowledge, Skills, Abilities, Tools, and Resources (KSATRs) in CPM.

The CPM allows you to create a Curriculum Outline of Instruction (COI) for a course, comprised of Modules, Lessons and Sections that are linked to the JDTA items.

- In a Course you will select one or more Modules
- In a Module you will select one or more Lessons.
- In a Lesson you will create the Terminal Objective and outline one or more Sections that support the Lesson.
- In a Section you will create the Enabling Objective.

These objectives serve as the basis for developing ILE-compliant Lessons and Sections.

When the Learning Objectives have been completed, they will be linked to their corresponding JDTA items.

Figure 1-1. CPM and LO Module in the ILE Architecture
1.3 DOCUMENT OVERVIEW

This document describes the functional capabilities for the CPM application. It is based on the results of an analysis of current ILE training-related processes and operations.

This document is organized as follows:

Chapter 1 – INTRODUCTION: Provides a full identification of the CPM application, a brief statement of the purpose of the application, registration information, summary of the document contents, and a description of user account management and privileges.

Chapter 2 – HOME: Opens automatically on login. From the Homepage the CPM user has the ability to view their assigned Project titles, System Announcements, Tasks, Messages, and Events. Using the Homepage menu items the CPM user can:

- Create/Edit/Delete Events,
- Create, Reply, Forward and Delete Messages,
- Create/Edit/Delete Assignments
- Edit personal Profile,
- View System Users information, and
- Change Password.

Chapter 3 – Data: The data tab provides an area where the Administrator, or those with specific privileges, can manage data elements for:

Chapter 4 - OCCSTDs: The OCCSTDs tab is where Occupational Standard information can be added, viewed or edited.

Chapter 5 – JDTA: The JDTA tab provides an area where skills and performance data JDTA can be viewed.

Chapter 6 – Projects: The Projects tab provides an area where: projects can be created and managed, Training Project Plan (TPP) and Training Course Control Documents (TCCD) data can be entered, JDTA can be selected for a project, Curriculum Outline of Instruction (COI) can be developed and Reports can be displayed.

Chapter 7 – Reports: The Reports tab provides a place to select and run reports on CPM data.
Chapter 8 - Resources: The Resources tab provides an area where different types of resources can be added to the database.

Chapter 9 - Admin: The Admin tab provides an area where the System and Center Administrators can add and edit CPM User information, identify User and Project Roles, identify Centers, edit Training Task Analysis (TTA) Data and create, edit, print and delete announcements.

1.4 REFERENCED DOCUMENTS

The following documents were used as references in preparing this specification:

- NETCINST 1510.4 Job Duty Task Analysis Policy
1.5 CREATING A CPM ACCOUNT

Accessing the [https://navyile.fedsun.navy.mil/CPM/](https://navyile.fedsun.navy.mil/CPM/) web page will open the CPM login page. For those that do not have a login click on ‘Don’t have an account? Create One!’ Refer to Figure 1-2.

![Figure 1-2. New User Account](image)

To create a CPM User account you are required to fill in the fields with the following information:

- First Name*
- Last Name*
- Email*
- Center*: Users shall be associated with one (lead) Center during the registration process. Additional Center associations may be added later.
- Requested Role (refer to next page for Role Assignments), Roles are assigned by CPM Administrators.
- Phone Number and DSN if applicable
- Address
- Comments
- Description
- Rank/Title and Organization
- Password* and Verify Password*. Users have the ability to change their password once they have successfully logged in.

Note: * Indicates a required field.
Requested Role can be:
- Career Directorate (N3)
- Commanding Officer
- Content Developer
- Content Developer Supervisor
- CPM Administrator
- CPM System Administrator
- Cybrarian
- Executive Officer
- ILE Implementation Specialist
- Knowledge Manager (N2/N6)
- Learning Standards Officer
- Other
- Rating Lead
- Resource Sponsor
- Skills Analyst
- Skills Analyst Supervisor
- Subject Matter Expert
- System Engineer
- Training Director (N9)
- Training Specialist
- Training Supervisor

When completed click on the **Submit** button. A confirmation page will appear for ten seconds. User registrations shall be approved by an Administrator. The CPM shall automatically generate a unique User ID from a combination of the user’s first and last name plus a number, if needed. You will be contacted by Email when the Center/System Administrator has added you to the list of users and you will have the privilege commensurate with your Role description. An email will be sent to the Center Administrator when a new user has successfully logged in to CPM for the first time.

Users can have only one User ID and password and can only register once. Users who are logged into the CPM shall be timed out after 30 minutes of inactivity and be required to log back into the site.

**1.5.1 User Account Management and Privileges**

End-user privileges are managed by either a System Administrator or designated administrators at each Center. They will define user profiles with specific access levels. Privilege levels will also be assigned based on the role of the user. The following bullets provide application functionality regarding user administration.

User activity will be tracked and monitored periodically by the System Administrator.
Users will be assigned *Roles* and *Views* within the CPM:

- **Roles**: Yes/No
  - CPM System Administrator: System administrators have the ability to change the owner of a content project and are able to delete projects entered by content users.
  - Center CPM Administrator: Center CPM administrators have the ability to change the owner of a content project assigned to the Center.
  - Supervisor

- **Views**: View/No View/Administrate
  - Data
  - Skills
  - Reports

- **Views**: View/No View/Edit/Administrate
  - Project
  - Leader

**CPM Privileges for each tab:**

**Privileges for the Data, Skills, Projects, and Reports tabs**

- None – CPM users assigned “None” will not be able to access these tabs.
- View – CPM users assigned “View” will only have view privileges for these tabs.
- Edit – CPM users assigned “Edit” will be able to add and modify data in Data, Skills, Projects, and Report tabs that they are assigned to as a team member and delete projects where they are assigned as the “Owner”
- Administrator - CPM users assigned “Administrator” will be able to add, modify, and delete data for all projects assigned to their Center.

**Privileges for the Admin Tab**

- System Administrator – have the ability to add, edit, delete any data cell in CPM. Should be reserved for the AIM/CPM Support Team both functional and technical experts.
- Center Administrator – access is intended for Center CPM Administrators for accepting/rejecting CPM User Accounts for their Center only and modifying roles for their personnel.
- None – access is for all CPM users that are not System/Center Administrators. This access allows them None, View, Editor, or Administrator privileges for the Data, Skills, Projects, Reports, and Admin Tab.
1.6 FORGOT YOUR PASSWORD?

If you forget your password just click on ‘Forgot your password?’ below the password field. Refer to Figure 1-3.

![Figure 1-3. Forgot Password](image)

Figure 1-3. Forgot Password

Enter the required information in the *fields provided and click on Submit. An Administrator will Email you and provide you with a password.
CHAPTER 2

HOME

2.0 HOME ................................................................................................ 2-1
2.1 EVENTS ................................................................................................ 2-1
2.2 MESSAGES .......................................................................................... 2-3
2.3 ASSIGNMENTS .................................................................................... 2-6
2.4 MY PROFILE ........................................................................................ 2-8
2.5 SYSTEM USERS ................................................................................... 2-8
2.6 CHANGE PASSWORD .......................................................................... 2-8
2.0 HOME

When you login to the Content Planning Module (CPM) the Home tab and menu items are enabled. From the Main menu item you can view projects you are creating or are a team member, assignments, messages sent and received by other system users, events, and system announcements. The Project Title area is an active field and when a Project Title is selected CPM will open the Project tab and Show the Details of the project.

The Home menu items consist of:
- Events – Create/Edit/Delete events
- Messages – Create/Send, Print and Delete messages to/from registered CPM users
- Assignments – Create/Edit/Delete Assignments
- My Profile – Edit the Profile originally created when you registered for CPM
- System Users – Contact information for registered CPM users
- Change Password – Change your password to another password

![Figure 2-1  CPM Home](image)

2.1 EVENTS

The Events menu item is where you will create your events.

The Events menu items consist of:
- New icon – Create a new event
- Delete icon – Delete an Event from the list
To create a new event:

Step 1  From the Content Planning Module window select the **Home** tab.

Step 2  Click on the **Events** menu item.

Step 3  Click on the **New** icon.

Step 4  Enter the desired information in the following fields:

- Title
- Location
- Start Date
- Start Time
- End Date
- End Time
- Note

Step 5  When complete click on the **Save** button. The event will appear in the list in the left hand pane by Event Title, Start Date and End Date. Once an Event has been added to the database, highlighting the Event in the left pane permits you to edit it in the right hand pane. **Cancel** will close the New Event pane and the event will not be added to the list in the left hand pane.

To delete an event from the list:

Step 1  From the Content Planning Module window select the **Home** tab.

Step 2  Click on the **Events** menu item.
Step 3  Click on the Event you want to delete in the list.

Step 4  Click on the **Delete** icon.

Step 5  Click on **OK** when asked for confirmation to delete the event or **Cancel** to return to the folder without deleting the event.

### 2.2 MESSAGES

Clicking on the Messages menu item opens your message center. There are two folders in Messages, Inbox and Sent Items. The default is Inbox when you access the Messages. Messages in your Inbox are displayed on the Home Page by date and subject. To select the Sent Items folder click on the down arrow and click on Sent Items. When either folder is open a list of messages received or sent will be displayed by who the message was from, subject and the date it was received in the left hand pane. When the message is highlighted in the left pane, the text of the message can be read in the right pane.

There are five icons associated with Messages:
- ![New](image) – Create a new message
- ![Reply](image) – Reply to a received message in your Inbox to the sender only.
- ![Reply to All](image) – Reply to a received message in your Inbox to all addressees.
- ![Forward](image) – Forward a highlighted message in your Inbox to other CPM users
- ![Delete](image) – Delete the highlighted message in your Inbox or Sent Items
- ![Print](image) – Print the highlighted message

![Figure 2-3 Messages](image)
To create a new message:

Step 1  From the Content Planning Module window select the **Home** tab to open the Homepage.

Step 2  Click on the **Messages** menu item.

Step 3  Click on the **New** icon.

Step 4  Click the down arrow in the right hand pane “**To**” field and select the CPM user the message will be sent to from the list.

Step 5  Click the down arrow in the right hand pane “**Cc**” field and select the CPM user the message will be copied to from the list if desired.

Step 6  Type the subject of the message in the “**Subject**” field.

Step 7  Type the content of the message in the **Content** field.

Step 8  When the message is complete click on the **Send** button. The message will appear in the Sent Items folder. Cancel will close the New Message pane and the message will not be sent.

To reply to a received message in your Inbox:

Step 1  From the Content Planning Module window select the **Home** tab to open the Homepage.

Step 2  Click on the **Messages** menu item.

Step 3  Click on the message you want to reply to in the Inbox.

Step 4  Click on the **Reply** or the **Reply to All** icon.

Step 5  Click the down arrow in the right hand pane “**Cc**” field and select the CPM user the message will be copied to from the list if desired.

Step 6  Type the content of the message you want to add for the Reply in the Content field.

Step 7  When complete click on the **Send** button. The message will appear in the Sent Items folder. Cancel will close the Message pane and the message will not be sent.
To forward a message in your Inbox to other CPM users:

Step 1  From the Content Planning Module window select the Home tab to open the Homepage.

Step 2  Click on the Messages menu item.

Step 3  Click on the message you want to forward in the Inbox.

Step 4  Click on the Forward icon.

Step 5  Click the down arrow in the right hand pane “To” field and select the CPM user the message will be forwarded to from the list.

Step 6  Click the down arrow in the right hand pane “Cc” field and select the CPM user the message will be copied to from the list if desired.

Step 7  Type additional content desired above the original message in the Content field.

Step 8  When the Forward message is complete click on the Send button. The message will appear in the Sent Items folder. Cancel will close the Message pane and the message will not be sent.

To delete a message from your Inbox or Sent Items folder:

Step 1  From the Content Planning Module window select the Home tab to open the Homepage.

Step 2  Click on the Messages menu item.

Step 3  Click on the message you want to delete in either the Inbox or Sent Items folder.

Step 4  Click on the Delete icon.

Step 5  Click on OK when asked for confirmation to delete the message or Cancel to return to the folder without deleting the message.

2.3 ASSIGNMENTS

The Assignments menu is where you will create your personal assignments.
The Assignments menu items consist of:

- New icon – Create a new Assignment
- Delete icon – Delete an Assignment from the list
- Print – Print the highlighted message

![Figure 2-4 Assignment Status](image)

**To create a new Assignment:**

**Step 1** From the Content Planning Module window select the **Home**.

**Step 2** Click on the **Assignments** menu item.

**Step 3** Click on the **New** icon.

**Step 4** Enter the desired information in the following fields:

- Title
- Start Date
- Status
  - Not Started
  - In Progress
  - Completed
  - Waiting
  - Deferred
- End Date
- Priority
  - Low
  - Normal
  - High
- Note
Step 5 When complete click on the **Save** button. The Assignment will appear in the list in the left hand pane by Title and on the Home Page by Start Date and Title. Once an Assignment has been added to the database, highlighting the Assignment in the left pane permits you to edit it in the right hand pane. **Cancel** will close the Task pane and the Assignment will not be added to the list in the left hand pane.

**To delete an Assignment from the list:**

1. Step 1 From the Content Planning Module window select the **Home** tab to open the Homepage.
2. Step 2 Click on the **Assignments** menu item.
3. Step 3 Click on the Assignment you want to delete in the list.
4. Step 4 Click on the **Delete** icon.
5. Step 5 Click on **OK** when asked for confirmation to delete the Assignment or **Cancel** to return to the folder without deleting the Assignment.

### 2.4 MY PROFILE

My Profile information is the same account information provided to the System Administrator to obtain a login and password for the CPM software. You can update your account information to keep it current. The System Administrator populates the Registration Date, Access, User ID and drop-down menu items.

### 2.5 SYSTEM USERS

The System Users menu item provides a list of all users identified in the CPM database by Name and Role:
- Last Name,
- First Name, and
- Role

Clicking on the user will reveal the Profile of the user which provides contact information.
2.6 CHANGE PASSWORD

The Change Password menu item provides a means to change your password in the database.

![Figure 2-5. Change Password](image)

Fill in the required fields and click on the save button to change your password.
# CHAPTER 3

## DATA

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.0</td>
<td>DATA</td>
<td>3-1</td>
</tr>
<tr>
<td>3.1</td>
<td>Center Filtering</td>
<td>3-2</td>
</tr>
</tbody>
</table>
3.0 DATA

The Data tab provides an area where the Administrator can add and edit specific data in the database.

When approved, this data is made available for use in other CPM tabs such as JDTA and Projects.

![Figure 3-1 Data Platforms](image1)

The data provided by EDE consist of:
- Platforms
- Systems
- Subsystem
- Components
- Non-Equipment
- Environments
- Tools
- Resources

![Figure 3-2 Data Verbs](image2)

The data provided by the Integrated Learning Environment (ILE) specifications for development of learning objectives consists of:
- Verbs
- Conditions
- Standards
Conditions and Standards can be added by the Center Administrators. Additions or deletions to the verb list is controlled by NETC N74. If an item is used in a Curriculum Outline of Instruction it cannot be edited or deleted.

The verbs cover the cognitive, affective and psychomotor domains.

Knowledge, Skill, Ability, Tool, and Resource (KSATR) items can be added to the Data tab by performing the following steps:

1. Select the KSATR submenu item from the Data tab.
2. Select the appropriate data item (Knowledge, Skill, Ability, Tool, or Resource) from the drop-down menu, see figure 3.3.
3. Select the New Icon from the Menu bar, see Figure 3.4 below.
4. Add the appropriate Text in the Title box, Type will be added based on the selection from the drop-down menu in Step 2.
5. Click the Save button.

To edit an existing KSATR perform the following steps:
1. Select the KSATR submenu item from the Data tab.
2. Select the appropriate data item (Knowledge, Skill, Ability, Tool, or Resource) from the drop-down menu, see figure 3.3.
3. Highlight the desired KSATR.
4. Click the Edit button in the right side pane.
5. Make the desired changes.
6. Click the Save button.

### 3.1 Center Filtering

Centers have the capability to filter any of the DATA sub-menu tabs to include only those items that pertain to the specific center. To filter on any of the sub-menu tabs complete the following steps:

1. Select the desired DATA tab sub-menu tab (Platform, System, Subsystem, Components, Non-Equipment, Environments, Tools, Resources, Verbs, Conditions, Standards, or KSATRs).
2. Click the Select icon (the blue circle with the white check mark).
3. Click the Edit button.
4. Select the desired items by clicking on the checkbox in the right-hand column.
5. There is also a Search feature above the list of items that can be used to search for specific items.
6. Once all items have been selected, click the Save button.
(This Page Intentionally Left Blank)
CHAPTER 4

OCCSTD (Occupational Standards)

4.0 OCCSTD ................................................................. 4-1
4.1 OCCSTD ................................................................. 4-1
4.2 Functional Areas ..................................................... 4-7
4.3 Pay Grade ................................................................. 4-7
4.0 OCCSTD

The OCCSTD tab is for NAVMAC use only. The OCCSTD tab is used for inputting Occupational Standards data. The tab has three main sections; OCCSTD, Functional Area, and Paygrade. The Functional Area and Paygrade tabs are used in support of the OCCSTD tab.

4.1 OCCSTD Main Screen

The left pane of the OCCSTD main screen contains a tree structure consisting of Centers. Each Center can be expanded to show the list of Rating belonging to that Center as seen in Figure 4-1 below.

To create a new Rating, with the appropriate Center highlighted, click on the New icon, as shown in Figure 4-2.
After clicking on the New icon the right pane of the display will contain a display with 2 tabs; OCCSTD and Scope/Description. The input text boxes for the OCCSTD tab are also displayed, as in Figure 4-3.

When creating a new Rating enter the Name and Short Title in the appropriate text boxes then select either Save to save and exit, or Save & Add to add another Rating. The Scope/Description tab displays a text box in the right pane, this text box is used to input the Scope/Description of the new Rating. Once the information for the new rating has been saved and with the new rating
highlighted in the left pane Service Ratings can be added by clicking on the New icon as shown in Figure 4-4.

After clicking the New icon the right pane will display two tabs; OCCSTD and Scope/Description. The input text boxes for the OCCSTD tab are also displayed, as in Figure 4-5. The Scope/Description tab is used for entering the Scope/Description of the new Service Rating.
After the information for the new Service Rating has been entered clicking on the '+' sign next to the new Service Rating title in the left pane will expand the Service Rating to show three folders; Tasks, OCCSTDs, and Jobs. To enter Tasks or Jobs highlight the appropriate folder and click the New icon as shown in Figure 4- 6.

![Figure 4- 6 Service Rating Tasks and Jobs](image)

The OCCSTD folder is populated from the Functional Areas tab as shown in Figure 4- 7. Adding Functional Areas is accomplished from the Functional Areas tab, which is covered later in this section.
To create new Tasks, with the Tasks folder highlighted, click on the New icon. The right pane will display two tabs, OCCSTD and Skills/Abilities, as shown in Figure 4-8.

The right pane of the OCCSTD tab includes drop-down menus for Verb, Paygrade, and Functional Area as well as a Text box for the name of the new Task. Once this information has been added either click the Save button to Save and exit or the Save & Add to save the current information and clear the screen to add another Task.

The information contained in the Paygrade and Functional Areas drop-down menus are developed in their associated tabs as seen in Figure 4-7 above and Figure 4-9 below. Verbs are created in the Data tab sub-section titled "Verbs".
The Skills/Abilities tab displays input boxes for Skills and Abilities. To input text click on the appropriate box, enter the desired text, click the Save button to save the information.

To create new Jobs, with the Jobs folder highlighted, click on the New icon. The right pane will display four tabs; OCCSTD, Jobs, Scope/Description, and DOD/O*NET, as shown in Figure 4-10.
The OCCSTD tab displays a text box for entering the name of the new Job. Once the name has been entered, the information can be saved by clicking the Save button, or the Save & Add button if another new Job is to be added.

The Job tab displays input text boxes for the following: Job Code, Job Family, NOC, Long Title, Short Title, Pay Plan, Career Field, Proficiency Level, and Relationships/Rules. To save Job information, click the Save button after all information has been entered.

The Scope/Description tab displays a text input box for entering the Scope and Description for the new Job.

The DOD/O*NET tab displays text input boxes for DOD and O*NET. The DOD input boxes are: Title, Group, Code, and Area. The O*NET input boxes are: Title, SOC Code, Name, and Family Code. To save this information, click the Save button.

### 4.2 Functional Areas

The Functional Areas left pane contains Functional Area titles. To add a Functional Area, click the New icon, this will display an input box in the right pane, enter the name of the new Functional Area, and click the Save button.

### 4.3 Pay Grade

The Pay Grade left pane contains Pay Grade titles. To add a Pay Grade, click the New icon, this will display two input boxes: Name and Sequence. The Name box is for the name of the Pay Grade, while Sequence is for the next Pay Grade in sequential order. After entering the appropriate information, click the Save button to save the new Pay Grade.
(This Page Intentionally Left Blank)
5.0 JDTA

The purpose of the Naval Education and Training Command's (NETC) Job Duty Task Analysis (JDTA) process is to establish a repeatable and defendable job analysis process to support content development or revision in order to satisfy fleet training requirements. At a minimum, the JDTA Process is designed to achieve the following goals:

- Provide a standard process for capturing all pertinent data to describe work performed in the fleet.
- Decompose and structure work.
- Apply appropriate attributes to the work, at the task level, to more comprehensively describe the work.

**NOTE:**
Before using the JDTA tab, be sure to read the NETC policy (NAVEDTRA 137) for conducting JDTA.

The JDTA tab contains the validated and approved data from the EDE. You can view your Center’s data to plan the content of your project.

The JDTA items are identified by:

- **Center** - A center is a major training command, such as the Center for Information Dominance.
- **Occupation** - An occupation is a family of jobs that share a common set of skills. A job family includes all jobs at various skill levels in a particular field of work. In the Navy, an occupation can be associated with a rating and is comprised of one or more jobs.
- **Job** - A job is comprised of duties and tasks. A job is composed of the duties, tasks, sub-tasks, and steps performed by an individual that constitute their job. A job is comprised of one or more duties and it may be associate with the appropriate NEC or watch station.
- **Duty** - A duty is a set of related tasks within a given job. A duty is a major part of a job. A duty is comprised of one or more tasks, it occurs frequently, and occupies a significant amount of time.
- **Task** - A task is a single unit of specific work behavior, with clear beginning and ending points. It is directly observable and measurable. Tasks are a major part of a duty and may be comprised of one or more sub-tasks. A task is comprised of logical
and distinct actions. A task is performed under a defined set of conditions and standards. Each task is independent of other tasks.

- **Subtask** - A sub-task is a major part of a task. A sub-task may be made up of a series of steps performed under the standards and conditions of a task. A sub-task has a logical relationship with a task, duty, job, occupation. A sub-task may be comprised of one or more steps and fills a portion of the immediate purpose within a task.

- **Step** - A step is a major part of a sub-task. A step is the most specific form of behavior, and is the smallest component defined in the process.

**To view the JDTA items identified for your center perform the following:**

**Step 1** From the CPM Homepage click on the **JDTA** tab.

The Centers are identified in the left hand margin. You can select to view **All**, **Approved**, **Accepted**, **Submitted**, **New**, or **Rejected** data for a Center by clicking the down arrow in the title bar. *Refer to Figure 5-1.*
Step 2 Highlight the desired center and explore the Occupations, Jobs, Duties, Tasks, Subtasks, and Steps identified for the center.
To select the contents of the Center:

Step 1 Highlight the desired center, click on the ‘+’ block next to the center and all the Occupations identified for the center will open.

Step 2 Click on the ‘+’ block next to the Occupation to open the Jobs of the desired Occupation.

Step 3 Click on the ‘+’ block next to the Job sub-folder to open the Duties for the Job selected.
Step 4 Click on the ‘+’ block next to the Duty sub-folder to open the Tasks for the Job selected.

Step 5 Click on the ‘+’ block next to the Task sub-folder to open the Subtasks and for the Task selected.

Step 6 Click on the ‘+’ block next to the Subtask sub-folder to open the Steps for the Subtask selected.

Step 7 Click on the Step sub-folder to view the Steps of the Subtask selected.

5.1 Occupation

The Occupation Tab is displayed in the right-hand pane when the Occupation is highlighted in the Left-hand pane. The elements of the Occupation Tab are:

- **Name**: The name of the occupation, this field is required.
- **Version**: The current version of the occupation, currently not editable.
- **Status**: Current status of the occupation, currently not editable.
- **Type**: JDTA type, currently not editable, should be Occupation.

There are no other tabs for a JDTA Occupation.

5.2 Job

The Job Tab is displayed in the right-hand pane when the Job is highlighted in the left-hand pane. There are two tabs associated with JDTA Jobs; the Job tab and the Job Attributes tab. The elements of the Job tab are:

- **Name**: The name of the job, this field is required.
- **Version**: The current version of the job, currently not editable.
- **Status**: Current status of the job, currently not editable.
- **Type**: JDTA type, currently not editable, should be Job.

To access the Job Attributes tab click on the tab in the right-hand pane. The elements of the Job Attributes tab are:

- **Mission**: The purpose of the job, this field is editable.
- **Description**: A detailed description of the job, this field is editable.
- **Rates**: Navy Rates that the job applies to, this field is editable.
- **NEC**: Navy Enlisted Classifications (NECs) that apply to the job, this field is editable.
- **DOL/ONET Occupation:** Department of Labor O*NET occupations can be entered here, access to O*NET can be accomplished by clicking on the blue hyperlink below this field, this field is editable.

**NOTE:**
None of the elements of the Job Attributes tab are required.

### 5.3 Duty

The Duty tab is displayed in the right-hand pane when the Duty is highlighted in the left-hand pane. There are three tabs associated with the JDTA Duties; the Duty, Existing Interventions, and KSATRs tabs. The elements of the Duty tab are:

- **Name:** The name of the duty, this field is required.
- **Version:** The current version of the duty, currently not editable.
- **Status:** Current status of the duty, currently not editable.
- **Type:** JDTA type, currently not editable, should be Duty.

To access the Existing Interventions tab click on the tab in the right-hand pane. The elements of the Existing Interventions tab are Type and Intervention. To enter a new Existing Intervention perform the following steps:

1. **Step 1** Click on the New icon.
2. **Step 2** Click on the Type dropdown.
3. **Step 3** Select the type of Existing Intervention from the dropdown menu.
4. **Step 4** In the Intervention text-box add appropriate text.
5. **Step 5** If a URL for the existing intervention exists it can be added by typing it in the Item URL: text box. Additionally, after the URL has been entered it can be launched by clicking on the Launch button.

**NOTE:**
While Existing Interventions are not required, if an Existing Intervention is added then Type and Intervention are required, Item URL is optional.

To access the KSATRs tab click on the tab in the right-hand pane. The elements of the KSATRs tab are Type and Text. To enter a KSATR perform the following steps:

1. **Step 1** Click on the Select icon.
Step 2  Click on the Type dropdown.

Step 3  Select the type of KSATR from the dropdown menu.

Step 4  Check all KSATRs that apply.

**NOTE:**
If the desired KSATR is not listed, click on the Filtering icon 🔄 to see a complete list. If the desired KSATR is still not listed click on the New icon 🔄 to add a new KSATR.

Step 5  Once all KSATRs of the selected type are selected, click the OK button.

Step 6  Repeat this process as needed through all KSATR types.

### 5.4 Task, Subtask, Step

The Task, Subtask, and Step screens have the same tabs with the exception of the TTA, which is only available on the Task screen. The Task, Subtask, or Step tab is displayed in the right-hand pane when the Task is highlighted in the left-hand pane. The tabs associated with the JDTA Task, Subtask, and Step are; Task, Subtask, or Step, Task Attributes, TTA (Training Task Analysis), Existing Interventions, and KSATRs. The elements of the main tab are:

- **Verb:**  This is a dropdown to select the type of verb. Selections include; Verb, Verb-Cognitive, Verb-Psychomotor, or Verb-Affective. The selection from this dropdown determines which verbs will populate the (Select Item) dropdown.
- **Select Item:**  Based on the selection from the Verb dropdown menu, a list of either all approved verbs or just Cognitive, Psychomotor, or Affective.
- **Text:**  This is the description of the task.
- **Version:**  The current version of the task, currently not editable.
- **Status:**  Current status of the task, currently not editable.
- **Type:**  JDTA type, currently not editable, should be Task.
- **Task Level:**  Dropdown menu to select the level the task will be performed. The options are; Organizational, Intermediate, Depot, or N/A.
- **Status of Training:**  Dropdown menu indicating what the current status of training is associated with the task. Options are; Currently Being Training, Not Being Trained, Not fully supported through current training.
- **Type of Training:**  Hyperlink to a checklist of different types of training. Options are; Formal, PQS, JQR, RTM, OJT, and Other.

**NOTE:**
All required items are identified by an asterisk (*).
To access the Task Attributes tab, click on the tab in the right-hand pane. The elements of the Task Attributes tab are:

- **Select Type:** This is a dropdown to select the type of data to use. The options are; Platform, System, Subsystem, Component, or Non-Equipment.

- **Select Item:** After the selection is made in the Select Type dropdown menu, the specific item can be selected from Select Item dropdown menu. By default this dropdown is filtered on center specific items, if the desired item is not show filtering can be turned off by selecting (Show All), then clicking on the dropdown triangle a second time.

- **Condition:** Clicking on the blue hyperlink will display a list of Conditions. One or more Conditions can be selected. By default Conditions are filtered by center, if the desired Condition is not seen initially, click on the Filtering icon , this will turn filtering off and a complete list of Conditions will be displayed. If the desired Condition is still not seen, click on the New icon to create a new Condition. The Condition screen also has a search feature when a keyword can be entered and any Condition containing the keyword will be listed.

- **Standard:** Clicking on the blue hyperlink will display a list of Standards. One or more Standards can be selected. By default Standards are filtered by center, if the desired Standard is not seen initially, click on the Filtering icon , this will turn filtering off and a complete list of Standards will be displayed. If the desired Standards is still not seen, click on the New icon to create a new Standard. The Standard screen also has a search feature when a keyword can be entered and any Standard containing the keyword will be listed.

- **Source:** Clicking on the blue hyperlink will display a list of Sources. One or more Sources can be selected. By default Sources are filtered by center, if the desired Source is not seen initially, click on the Filtering icon , this will turn filtering off and a complete list of Source will be displayed. If the desired Source is still not seen, click on the New icon to create a new Source. The Source screen also has a search feature when a keyword can be entered and any Source containing the keyword will be listed.

**NOTE:**

All fields of the Task Attributes tab are required.

To access the Training Task Analysis (TTA) tab, click on the tab in the right-hand pane. The elements of the Training Task Analysis are:

- **Safety Hazard Severity (Select List Item)**
  - Minor - Failure does not cause injury, property damage, or system damage but will result in unscheduled maintenance or repair.
  - Marginal - Failure may cause minor injury, minor property damage, or minor system damage, and will result in delay, loss of availability, or mission degradation.
  - Critical - Failure may cause severe injury, major property damage, or major system damage and will result in mission loss.
○ Catastrophic - Failure may cause death, property destruction, or system loss (e.g., aircraft, tank, missile, ship, etc.)

• Criticality of Performance (Select List Item)
  ○ Minor - Inadequate performance does not result in injury to personnel or damage to equipment.
  ○ Marginal - Inadequate performance results in non-serious personnel injury or damage to equipment.
  ○ Critical - Inadequate performance results in serious or life threatening injury to personnel, or impedes the ability to perform a mission.
  ○ Catastrophic - Inadequate performance results in death or inability to carry out a mission.

• Task Delay Tolerance (Select List Item)
  ○ Low Delay Tolerance
  ○ High Delay Tolerance

• Frequency of Performance (Select List Item)
  ○ At least annually
  ○ At least once every 6 months
  ○ At least monthly, but less than twice per week
  ○ Twice per week or more

• Probability of Inadequate Performance (Select List Item)
  ○ Never performed correctly
  ○ Less often than other tasks
  ○ About as often as other tasks
  ○ More often than other tasks

• Difficulty of Performance (Select List Item)
  ○ No training required
  ○ Task requires 1 to 3 days to learn
  ○ Task may be learned in 1 to 2 weeks
  ○ Task may require up to 1 month or more to learn

• Task Learning Difficulty (Select List Item)
  ○ No training required
  ○ Task requires 1 to 3 days to learn
  ○ Task may be learned in 1 to 2 weeks
  ○ Task may require up to 1 month or more to learn

• Percent Performing (Select List Item)
  ○ 0 to 24% of personnel perform this task
  ○ 25 to 49% of personnel performance this task
  ○ 50 to 74% of personnel performance this task
  ○ 75 to 100% of personnel performance this task

• Percent of Time Spent on Performance (Select List Item)
  ○ Task is not performed
  ○ Less time spent on this task than most other tasks
  ○ Same amount of time spent on this task as most others
  ○ More time spent on this task than most others

• Immediacy of Performance (Select List Item)
  ○ Task first performed within 2 to 4 years after assignment
To access the Existing Interventions tab click on the tab in the right-hand pane. The elements of the Existing Interventions tab are Type and Intervention. To enter a new Existing Intervention perform the following steps:

Step 1 Click on the New icon.
Step 2 Click on the Type dropdown.
Step 3 Select the type of Existing Intervention from the dropdown menu.
Step 4 In the Intervention text-box add appropriate text.
Step 5 If a URL for the existing intervention exists it can be added by typing it in the Item URL: text box. Additionally, after the URL has been entered it can be launched by clicking on the Launch button.

**NOTE:**

While Existing Interventions are not required, if an Existing Intervention is added then Type and Intervention are required, Item URL is optional.

To access the KSATRs tab click on the tab in the right-hand pane. The elements of the KSATRs tab are Type and Text. To enter a KSATR perform the following steps:

Step 1 Click on the Select icon.
Step 2 Click on the Type dropdown.
Step 3 Select the type of KSATR from the dropdown menu.
Step 4 Check all KSATRs that apply.

**NOTE:**

If the desired KSATR is not listed, click on the Filtering icon to see a complete list. If the desired KSATR is still not listed click on the New icon to add a new KSATR.

Step 5 Once all KSATRs of the selected type are selected, click the OK button.
Step 6 Repeat this process as needed through all KSATR types.

5.5 To add a new Occupation, Job, Duty, Task, Subtask, or Step:

Step 1 Highlight the desired center, click on the ‘+’ block next to the center and all the Occupations identified for the center will open.

Step 2 Highlight the appropriate folder to add the new item as follows:
   a. Center to add a Occupation
   b. Occupation to add a Job
   c. Job to add a Duty
   d. Duty to add a Task
   e. Tasks to add a Subtask
   f. Subtask to add Step

Step 3 Click on the New icon. To add another item at the same level use the "Save and Add" button.

Step 4 In the right hand pane enter the applicable information in the following fields:
   a. For a New Occupation:

   ![Figure 5-5 OCCUPATION TAB](image)

   - Enter the Name of the Occupation in the Skill tab and click on the Save button.
Click on the Show Privileges icon and identify the personnel that will Approve, View, Edit, or Review the JDTA items for the Occupation. Save your selections, by clicking on the Save button, when completed.

Figure 5-6 SELECTING PRIVILEGE for an OCCUPATION

Click on the Occupation title in the left pane. Click on the Submit button in the right hand pane to submit your new Occupation for Approval when completed. Note that the status of an item will change from New to Submitted. Other status indicators are Approved, Accepted, and Rejected.

After it has been submitted, new buttons will appear in the left hand screen for Accepted and Rejected. Once Accepted a button will appear for Approved.
b. For a New Job:
   • Enter the Name of the Job in the Skill tab and click on the Save button.
   • Enter the applicable information in the Job tab which contains text fields for Mission, Description, Rate, NEC, and DOL/ONET Occupation. Save your entries.

   Figure 5-7  JOB TAB for a JOB

   • Click on the Job title in the left pane. Click on the Submit button in the right hand pane to submit your new Job for Approval when completed. Note that the status of an item will change from New to Submitted. Other status indicators are Approved, Accepted, and Rejected. After it has been submitted, new buttons will appear in the left hand screen for Accepted and Rejected. Once Accepted a button will appear for Approved.
c. For a New Duty:
   • Enter the Name of the Duty in the Skill tab and click on the Save button.
   • Enter information in the Existing Interventions tab by clicking on the New 
     icon, select the type from the drop down menu and identify the 
     Intervention in the field provided. Save your entries when completed.
   • To add KSATRs for a new Duty perform the following steps:
     i. Click on the KSATRs tab.
     ii. Click the Edit button.
     iii. Click on the Select  icon.
     iv. Select the desired KSATRs for each type by first selecting the 
        type from the Type drop-down menu, then checking the desired 
        KSATR from the list provided. (Note: By default only KSATRs 
        for the current site are displayed, if the desired KSATR is not 
        shown click the Filter  icon. This will display all KSATRs 
        of a given type.)

![Figure 5-8 KSATRs TAB for a DUTY]

   • Click on the Duty title in the left pane. Click on the Submit button in the 
     right hand pane to submit your new Duty for Approval when completed. 
     Note that the status of an item will change from New to Submitted. Other 
     status indicators are Approved, Accepted, and Rejected. After it has been 
     submitted, new buttons will appear in the left hand screen for Accepted 
     and Rejected. Once Accepted a button will appear for Approved.
d. For a New Task:

![Figure 5-9 TASK TABS](image)

- In the Task Tab:
  1. Select the appropriate verb for the task from the drop-down list.
  2. Enter the text of the Task in the Text field.
  3. Using the drop-down menu select the Task Level as Intermediate, Organizational, Depot or N/A.
  4. Using the drop-down menu select the Status of Training as Currently Being Trained, Not Being Trained, or Not fully supported through current training.
  5. Click on the Type of Training hyperlink and select/unselect the Type of Training. Click on OK.

![Figure 5-10 TYPE of TRAINING SELECTION](image)

(6) Save your entries on the Task tab.
In the Task Attributes Tab:

- Select the Component (Platforms, Systems, Subsystems, Components, or Non-equipment) from the drop down menu.
- In the Object field click on the down-arrow and select the object related to the type selected in Step 1.
- Click on the Condition hyperlink and select the condition from the list.
- Click on the Standard hyperlink and select the standard from the list.
- Click on the Source hyperlink and select the source from the list.
- Click on the Save button to save your selections.

- Enter the desired information in the Existing Interventions tab and save your entries.
- To add KSATRs for a new Task perform the following steps:
  - Click on the KSATRs tab.
  - Click the Edit button.
  - Click on the Select icon.
  - Select the desired KSATRs for each type by first selecting the type from the Type drop-down menu, then checking the desired KSATR from the list provided. (Note: By default only KSATRs for the current site are displayed, if the desired KSATR is not shown click the Filter icon. This will display all KSATRs of a given type.)

- Click on the Task title in the left pane. Click on the Submit button in the right hand pane to submit your new Task for Approval when completed. Note that the status of an item will change from New to Submitted. Other status indicators are Approved, Accepted, and Rejected. After it has been submitted, new buttons will appear in the left hand screen for Accepted and Rejected. Once Accepted a button will appear for Approved.
e. For a New Subtask:

For a New Subtask:

![SUBTASK TABS](image1)

**Figure 5-12 SUBTASK TABS**

- Enter the Name of the Subtask in the Skill tab and click on the Save button.

![SUBTASK ATTRIBUTES TAB](image2)

**Figure 5-13 SUBTASK ATTRIBUTES TAB**

- In the Subtasks Attributes Tab:
  1. Select the Type (Platforms, Systems, Subsystems, Components, or Non-equipment) from the drop down menu.
  2. In the Object field click on the down-arrow and select the object related to the type selected in Step 1.
  3. Click on the Condition hyperlink and select the condition from the list.
  4. Click on the Standard hyperlink and select the standard from the list.
  5. Click on the Source hyperlink and select the source from the list.
  6. Click on the Save button to save your selections.
• Enter information in the Existing Interventions tab by clicking on the New icon, select the type from the drop down menu and identify the Intervention in the field provided. Save your entries when completed.

• To add KSATRs for a new Subtask perform the following steps:
  i. Click on the KSATRs tab.
  ii. Click the Edit button.
  iii. Click on the Select icon.
  iv. Select the desired KSATRs for each type by first selecting the type from the Type drop-down menu, then checking the desired KSATR from the list provided. (Note: By default only KSATRs for the current site are displayed, if the desired KSATR is not shown click the Filter icon. This will display all KSATRs of a given type.

• Click on the Subtask title in the left pane. Click on the Submit button in the right hand pane to submit your new Subtask for Approval when completed. Note that the status of an item will change from New to Submitted. Other status indicators are Approved, Accepted, and Rejected. After it has been submitted, new buttons will appear in the left hand screen for Accepted and Rejected. Once Accepted a button will appear for Approved.
f. For a New Step:

**Figure 6-14 STEP TABS**

- Enter the Name of the Step in the Skill tab and click on the Save button.

**Figure 6-15 Step Attributes Tab**

- In the Step Attributes tab:
  1. Select the Type (Platforms, Systems, Subsystems, Components, or Non-equipment) from the drop down menu.
  2. In the Object field click on the down-arrow and select the object related to the type selected in Step 1.
  3. Click on the Condition hyperlink and select the condition from the list.
  4. Click on the Standard hyperlink and select the standard from the list.
  5. Click on the Source hyperlink and select the source from the list.
  6. Click on the Save button to save your selections.
• Enter information in the Existing Interventions tab by clicking on the New icon, select the type from the drop down menu and identify the Intervention in the field provided. Save your entries when completed.
• To add KSATRs for a new Step perform the following steps:
  i. Click on the KSATRs tab.
  ii. Click the Edit button.
  iii. Click on the Select icon.
  iv. Select the desired KSATRs for each type by first selecting the type from the Type drop-down menu, then checking the desired KSATR from the list provided. (Note: By default only KSATRs for the current site are displayed, if the desired KSATR is not shown click the Filter icon. This will display all KSATRs of a given type.
• Click on the Step title in the left pane. Click on the Submit button in the right hand pane to submit your new Subtask for Approval when completed. Note that the status of an item will change from New to Submitted. Other status indicators are Approved, Accepted, and Rejected. After it has been submitted, new buttons will appear in the left hand screen for Accepted and Rejected. Once Accepted a button will appear for Approved.

NOTE:
JD TA items can also be "Bulk Submitted, Accepted and Approved" by clicking on the Bulk Submit/Accept/Approve Icon and selecting the appropriate action from the drop-down menu.

5.6 Importing CTTL Data

It is possible to import CTTL data from AIM II v5.1. To create the required Excel spreadsheet perform the following steps:

1. From AIM II v5.1 Main Menu select **Utilities**.
2. From the **Utilities** Menu select **Reporting**.
3. From the **Reporting** screen select the **Data Output** tab.
4. From the **Data Output** tab highlight **Output CTTL to Excel**.
5. From the **Options** Menu select **Generate**, this will display the **Select Course** screen.
6. From the Select Course screen highlight the desired course and select Select from the Main Menu. This will display the Select Output File window.

7. In the Select Output File window select a location and name for the output file, remember this name and location.

8. Acknowledge file creating message and exit AIM II v5.1.

To import the CTTL data created in the previous steps into CPM JDTA perform the following steps:

1. From the JDTA tab select the appropriate Occupation and Job.

2. With the appropriate Job highlighted select the Import icon . The CTTL Data Import Delimited Text (*.csv) screen appears, input or browse to the file that was created earlier from AIM II v5.1 and click Upload.

3. Once the file has been uploaded a screen displaying CTTL data will appear.

4. From the CTTL Data screen select the desired Duties and tasks for the Job that is highlighted in the left pane by clicking on the check box next to the desired item in the CTTL Data screen.

5. This process can be used to select Duty, Task, Subtask and Step. For Subtasks and Steps be sure to use the drop-down menu on the Skill column to select the appropriate level (Subtask or Step).

### 5.2 Center Filtering

Starting at the Task level some of the available inputs may have been filtered by the center at the Data tab. Refer to the table below to identify where inputs may be filtered.

<table>
<thead>
<tr>
<th>Input</th>
<th>JDTA tab effected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verb</td>
<td>Task, Subtask and Step</td>
</tr>
<tr>
<td>Platform, Systems, Subsystems, Components,</td>
<td>Task, Subtask and Step</td>
</tr>
<tr>
<td>Non-Equipment</td>
<td>Attributes</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions link on Task, Subtask and Step</td>
</tr>
<tr>
<td></td>
<td>Attributes tab</td>
</tr>
<tr>
<td>Standard</td>
<td>Standards link on Task, Subtask and Step</td>
</tr>
</tbody>
</table>

Release 5.1 5-21
Filtering can be turned off by selecting the (Show All) option for Verbs, Platforms, Systems, Subsystems, Components, and Non-Equipment. For Conditions and Standards clicking on the Filter icon will toggle filtering on/off.
(This Page Intentionally Left Blank)
CHAPTER 6

PROJECTS

6.0 PROJECTS ........................................................................................................... 6-1
6.1 Projects Window .......................................................................................... 6-1
6.2 Project Management ..................................................................................... 6-2
   6.2.1 Team Members ...................................................................................... 6-3
   6.2.2 Assignments .......................................................................................... 6-4
   6.2.3 TPP and TCCD ...................................................................................... 6-7
      6.2.3.1 TPP/TCCD Course Information ......................................................... 6-8
      6.2.3.2 Foreword .......................................................................................... 6-9
      6.2.3.3 Course Overview ............................................................................ 6-9
      6.2.3.4 Course Status .................................................................................. 6-9
      6.2.3.5 Development Method ..................................................................... 6-10
      6.2.3.6 Trainee Data .................................................................................... 6-10
      6.2.3.7 Justification ...................................................................................... 6-11
      6.2.3.8 Milestones ....................................................................................... 6-12
      6.2.3.9 Safety Risks and Hazardous Materials ........................................... 6-12
      6.2.3.10 Course Mission Statement .............................................................. 6-12
      6.2.3.11 Occupational Classification/Prerequisite ......................................... 6-13
      6.2.3.12 Instructor/Support Manning ............................................................ 6-13
      6.2.3.13 Training Sites .................................................................................. 6-13
6.3 Curriculum Development ............................................................................. 6-14
   6.3.1 Performance Requirements ................................................................... 6-14
   6.3.2 Curriculum Outline of Instruction (COI) ................................................. 6-17
      6.3.2.1 Delivery Method .............................................................................. 6-17
      6.3.2.2 Adding a Module to a Course .......................................................... 6-19
      6.3.2.3 Adding a Lesson to a Module ............................................................ 6-20
      6.3.2.4 Adding a Section to a Lesson ............................................................ 6-23
6.4 Reports ............................................................................................................ 6-25
6.0 PROJECTS

The Projects tab provides an area where you can:

- Create and manage Projects
- Develop a Training Project Plan (TPP) and Training Course Control Document (TCCD) for Curriculum
- Develop Curriculum Outline of Instruction (COI)
- Develop Reports

6.1 PROJECTS WINDOW

Selecting the Projects tab from the CPM Homepage opens the Projects window. The Projects default to My Projects in the drop-down, and lists the projects in which you have been designated as a Team Member and the projects you created. From the drop-down arrow you can also select All, Active, Testing, and Inactive projects. From this window you can create a New Project, Show Details of an existing project, Deactivate a Project you created, Export a Project to EDE when completed, or Import. The project Resource Requirements List (RRL) from the EDE. Refer to Figure 6-1.

![Figure 6-1. Projects](image)
To create a New Project:

From the Projects window click on the New project icon. This will open a window where you can enter the data for:

- Title
- Status
- Center
- Start Date
- End Date

The software automatically captures your name for Owner and the Status defaults to Incomplete.

The new project will be added to the list when you click on the Save button.

6.2 PROJECT MANAGEMENT

Project Management provides an area where you can identify Team Members, create Assignments for the Team and develop a Training Project Plan (TPP) and Training Course Control Document (TCCD).

To add project management data:

Step 1 From the Projects window highlight the desired project in the list and click on the View icon. Refer to Figure 6-1.

Step 2 Open the Project Management folders by clicking on the adjacent ‘+’ block.

Step 3 Click on “Project Management”. This will open the project properties window that was created when the project was created. The Title, Start Date, End Date and Owner and can be edited by clicking on the Edit button. Refer to Figure 6-2.
The Project Management window contains folders for identifying:

- Project content information
- Team Members that are going to work on the project,
- Assignments
- Change Record
- Course information contained in both TPP and TCCD
- TPP information, and
- TCCD information.

### 6.2.1 Team Members

**To identify the team members responsible for the project:**

**Step 1** Click on the **Team Member** folder in the Project Management tree structure. This will open the Team Members window that displays the Name of all Active CPM Users. Refer to Figure 6-3.

**Step 2** Click the Edit button then select the users that will be members of the team for the project by clicking on the member’s **Role** column, clicking on the down arrow, and selecting from one of the following for each of the members:

- a. Content Developer
- b. Instructional Designer
- c. MT (MPA) - COI
- d. Project Editor
- e. Rating Lead
- f. Subject Matter Expert
- g. TCCD Approver
h. TPP Approver.

**NOTE:**
The Project role supersedes the CPM System role, for example someone with a "View Only" system role can be granted "Project Editor" for a project and will have broad authority with that project.

Step 3  Click on the Save button to save your selections.

![Figure 6-3. Team Members](image)

### 6.2.2 Assignments

The Assignments folder will contain all the Assignments of the project. When the Assignments are added here they are also added to the Assignments on the Homepage for all Team Members.

The Assignments menu items consist of:
- ![New icon] New icon – Create a new Assignment
- ![Delete icon] Delete icon – Delete an Assignment from the list

**To create a new Assignment:**

**Step 1**  Open Project Management folder by clicking on the adjacent ‘+’ block.

**Step 2**  Click on the **Assignments** folder.

**Step 3**  Click on the **New** icon. Refer to Figure 6-4.
Step 4  Enter the desired information in the following fields:

- Title
- Start Date
- Status
  - Not Started
  - In Progress
  - Completed
  - Waiting
  - Deferred
- End Date
- Priority
  - Low
  - Normal
  - High
- Note

Step 5  When complete click on the Save button. The Assignment will appear in the list in the Assignment Title pane and on the Home Page by Start Date and Title. Once an Assignment has been added to the database, you will be able to assign a user to the Assignment. Refer to Figure 6-5.
Step 6  Click on Assigned Users to select the user(s) the assignment was created for. Refer to Figure 6-6.

**Figure 6-5. Assigned Users**

**Figure 6-6. Selecting Assigned Users**

**NOTE:** The creator of the assignment is selected by default and can be unselected.

Step 7  Click on the select box to enter a check mark and identify the Team Member that the Assignment is intended for.

Step 8  Click on the Save button.
To delete an Assignment from the list:

Step 1  Open Project Management folder by clicking on the adjacent ‘+’ block.

Step 2  Click on the Assignments folder.

Step 3  Click on the Assignment you want to delete in the list.

Step 4  Click on the Delete icon.

Step 5  Click on OK when asked for confirmation to delete the Assignment or Cancel to return to the folder without deleting the Assignment.

6.2.3  **Training Project Plan (TPP) and Training Course Control Document (TCCD)**

A curriculum development project begins with planning, i.e., the gathering of information and the building of a plan for training material development. The output product of curriculum development planning is the Training Project Plan (TPP), which upon approval by the Curriculum Control Authority (CCA) becomes the authorization to undertake a new course development project.

**NOTE:**

Before starting a TPP or Project, review NETC policies related to Front End Analysis (FEA) and Business Case Analysis (BCA).

A TPP consists of the following elements (as applicable) in the ILE Project portion of the CPM:

- TPP/TCCD Course information
- Course Overview
- Course Status
- Development Method
- Justification for the Course, that includes:
  - References
  - Reason/Source of Information
  - Summary of Differences (for a Revision)
  - Impact If Not Approved
- Milestones
- Safety Risks and Hazardous Materials
- Course Mission Statement
- Occupational Classification/Prerequisite
- Training Sites/Course Data
- Resource Requirements List (RRL)

When the TPP is approved by the CCA the emphasis changes to the development of TCCD materials.
A TCCD consists of the following elements (as applicable) in the ILE Project portion of the CPM:

- TPP/TCCD Course information
- Foreword
- Course Overview
- Trainee Data
- Course Mission Statement
- Occupational Classification/Prerequisite
- Instructor/Support Manning
- Training Sites/Course Data
- Course Master Schedule (CMS)
- Resource Requirements List (RRL)

### 6.2.3.1 TPP/TCCD Course Information

The TPP/TCCD course folder contains information that is common to both the TPP and the TCCD and is where you will enter the following course information, as applicable, in the fields provided and save the information to the database: *Refer to Figure 6-7.*

- Course Title
- Course Status: Incomplete, Complete, Locked for Review, or Approved
- CIN (Course Identification Number)
- Starting Fiscal Year
- Check box to identify CNATT compliant ERL data
- Training Type
- Work Center
- Prepared By
- Prepared For
6.2.3.2 Foreword

The foreword is not a required element of the TCCD but is a place to explain to reviewers any unique aspect of the course, which may not be apparent from the basic data.

6.2.3.3 Course Overview

List the course subjects. Note any changes from the previous project plan. For a new course this will be a description of the skills and knowledge to be attained. This is not intended to be the equivalent of a curriculum outline, or to contain objectives. The overview helps identify what the course will actually contain.

6.2.3.4 Course Status

- New - course or new to your Training Activity.
- Revision - A modification to any course terminal objective, increase in course length, or training material change that requires additional resources.
- Deactivation - Course will no longer be taught at your activity, or another activity for which you are CCMM for, and is not being replaced by another course.
6.2.3.5 Development Method

The Development Method element of the TPP contains information about the documents that will be produced, Learning Objects, and Mode of Instruction for the course if the TPP is approved by the CCA. Refer to Figure 6-8.

![Figure 6-8. Development Method](image)

6.2.3.6 Trainee Data

The Trainee Data element of the TCCD consists of personnel physical requirements, security clearances, obligated service, and NOBC/NEC/MOS earned. Refer to Figure 6-9.

![Figure 6-9. Trainee Data](image)
6.2.3.7 Justification

There must be a reason (or reasons) to undertake the development of a new course or the revision of an existing course. The justification for initiating the development of a new course or the revision of existing training materials can come from:

- Navy Training Plans (NTPs) (OPNAVINST 1500.8)
- Tasking by higher authority
- Internal course reviews and local command initiatives
- External course reviews
- Surveillance and external feedback
- Training appraisal

1. Reference - The principal document for stating billets, personnel, military construction, and training material support requirements of the system, subsystem, components, or non-hardware oriented development, to produce trained and qualified personnel required to install, operate, maintain, or otherwise use the same being introduced into the Navy.

2. Reason/Source of Information for new course, revision, or cancellation:

   New - Justification for expenditures of funds to support new training: No existing training for Fleet need; new hardware requiring operator and/or maintenance skills; NTP driven.

   Deactivation - Fleet no longer requires this training, training is not cost effective: Obsolescence due to platform or equipment upgrades: training can be accomplished on-board: Training Realignment - course is no longer taught at one or more locations.

   Change Directive: Tasking document which directs course revision, cancellation, or new course development. Examples include: Navy Training Requirements Review (NTRR) action items, Technical Training Audit action items, etc.

3. The Summary of Differences is added when a TPP is being developed for a revision to a course. In general, a revision means that the course mission has changed, course length is increased, or additional resources are required. Identify the differences from the approved training material.

4. Impact If Not Approved: Clearly describe the impact on fleet requirements and capabilities if the proposal is not undertaken.
6.2.3.8 Milestones

A time-phased narrative commencing with TPP approval, milestones shall include identification of major developmental products or events relating to the training materials development method selected, and end with implementation. Projected completion dates for each key event shall be indicated.

To edit an existing Milestone, highlight the Milestone and click the Edit button. To delete a Milestone, highlight the Milestone and click the Delete icon.

Click on the New icon and enter the Title, Location, Start and End Dates. A Note field is provided to explain the Milestone in detail if required. When completed, click on the Save button to save the milestone for the project. Refer to Figure 6-10.

Figure 6-10. TPP Milestones

6.2.3.9 Safety Risks and Hazardous Materials

Input any safety related issues or concerns.

6.2.3.10 Course Mission Statement

For a new course you should answer the following questions: Train who?; To do what?; Where?; Under what conditions?; What degree of qualification will be brought about by this training?
6.2.3.11 Occupational Classification/Prerequisite

- List the NEC/NOBC/MOS awarded upon completion of the course. If no classification exists or if a classification has been requested say so here.
- Describe the personnel eligible to attend the course.

6.2.3.12 Instructor/Support Manning

Requirements for Instructor and Support Manning are entered in this text box.

6.2.3.13 Training Sites

Training Activity to which the Course Data applies. The Course Data is required for each activity that teaches the course. Refer to Figure 6-11.

![Figure 6-11. TPP/TCCD Training Sites](image)

To add a Training Site:

- **Step 1** Click on the Training Sites element or an existing Training Site.
- **Step 2** Click on the ![New icon](image).
- **Step 3** Enter the Site Name and the CDP if assigned.
- **NOTE:** For a New TPP enter information in the Planned columns. For a Revision TPP enter information in both Current and Planned.
- **Step 4** Enter the Class and Lab hours in the appropriate fields. Enter hours in the PA (Practical Application) fields, a CNATT identifier, if applicable.
- **Step 5** Enter the Minimum and Maximum Class Capacities.
Step 6   Enter the number of times the course will be taught in a year in the Class Convenings field.

Step 7   Enter the number of students you expect will graduate from this course in a year in the Student Throughput field.

Step 8   Enter any additional Site Considerations in the "Site Considerations" text box.

Step 9   Click on the Save button. Average on Board will be computed by the software

6.3   CURRICULUM DEVELOPMENT

The curriculum development portion of the project is where you will select the performance requirements and develop the Curriculum Outline of Instruction (COI) for the Course.

6.3.1   Performance Requirements

Under the Performance Requirements folder you will select the Occupations, Jobs, Duties, Tasks, Subtasks, and Steps for the training you are developing. Refer to figure 6-12.

Figure 6-12. COI Performance Requirements – Occupations
To select the applicable Occupation for your Center:

Step 1  Open the Curriculum Development folder by clicking on the adjacent ‘+’ block.

Step 2  Open the Performance Requirements folder by clicking on the adjacent ‘+’ block.

Step 3  Click on the Occupation sub-folder to open the Occupations window for your Center.

Step 4  Click on the check block/s to select the Occupation/s that will take the course.

Step 5  Click on the Save button.

To select the applicable Jobs for the Occupation/s selected:

Step 1  Click on the Jobs sub-folder to open the Jobs for the Occupation/s selected.

Step 2  Click on the check block/s to select the Job/s.

Step 3  Click on the Save button.

To select the applicable Duties for the Job/s selected:

Step 1  Click on the Duties sub-folder to open the Duties for the Job/s selected.

Step 2  Click on the check block/s to select the Duties .

Step 3  Click on the Save button.

To select the applicable Tasks for the Duties selected:

Step 1  Click on the Tasks sub-folder to open the Tasks for the Duties selected.

Step 2  Click on the check block/s to select the Task/s .

Step 3  Click on the Save button.
To view the applicable Subtasks for the Tasks selected:

Click on the Subtasks sub-folder to view the Subtasks for the Task/s selected.

Suggested New Subtasks can be submitted for approval through your CPM System Administrator. Refer to Figure 6-13.

![Figure 6-13. COI Performance Requirements – Subtasks](image)

To view the Steps for the Subtasks selected:

Click on the Steps sub-folder to view the Steps for the Subtasks for the Tasks selected.

### 6.3.2 Curriculum Outline of Instruction (COI)

The folder identified by the icon of three books side by side is your course title, identified in the Course Data of your TPP. From this folder you will create the COI for your course that will contain:

- The Course Title
- Modules that can contain one or more Lessons
- Terminal Objective for each Lesson
- Lessons that can contain one or more Sections
- Enabling Objective for each Section

In addition to the course icon, a Module is identified by a single diagonal book, a Lesson by a box, a Section by three horizontal lines and a Terminal or Enabling Objective by a plum colored and underline Objective.
The icons of the COI are color coded to identify their status:

- Pink – Title linked to a Skill Group
- Blue – Title linked to a Task
- Orange – Title linked to a Sub-Task
- Yellow - Title was developed from a Step
- Green – Unique Knowledge
- Gray - No link assigned

6.3.2.1 Delivery Method

To enter the delivery method for the Course:

Step 1  Click on the Course icon.

Step 2  Click on the drop-down arrow in the Delivery Method field and select the appropriate method. Refer to Figure 6-14.

Step 3  Click on the Save button.
To add ISD Considerations information for your Course:

Step 1  Click on the ISD Considerations link. Refer to Figure 6-15.

Step 2  Click on the desired item, add your comments in the text field.

Step 3  Click on the Save button.
6.3.2.2 Adding a Module to a Course

Modules can be created from Skill Basis: Skill Group or Tasks and Attributes: Ability, Knowledge, Resource, Skill or Tool. If no data is present in the database for the Module being developed you can select None to add the Module title.

To add a Module to the COI:

Step 1 Click on the Title of your course.

Step 2 Click on the New icon. Refer to Figure 6-16.

Step 3 Enter the title of the Module in the Module Title field.

Step 4 Select the delivery method from the drop-down menu.

Step 5 Select the Skill Basis from the drop-down menu: (None) or Duty.

Step 6 If Duty was selected, click on the drop-down arrow in the adjacent field and select the appropriate item for the Duty.

If the menu is blank, there are no items of this type linked to the Performance Requirements selected, in which case you can select the (None item for the Skill Basis).

Step 7 After clicking the Save button click on the ISD Considerations link.

Step 8 Add information for the appropriate ISD Considerations for the Module. Refer to Figure 6-17.
Figure 6-17. ISD Considerations for Module

Step 9 Click on the Save button to save your Module.

6.3.2.3 Adding a Lesson to a Module

Adding a Lesson to a Module is accomplished by completing two processes: Adding the title of the Lesson to the Module and developing a Terminal Objective Statement to the Lesson.

To add a Lesson to a Module:

Step 1 Click on the desired Module of your course in the COI tree structure.

Step 2 Click on the New icon. Refer to Figure 6-18.
Step 3 Enter the title of the Lesson in the Lesson Title field.

Step 4 Select the delivery method from the drop-down menu.

Step 5 Select the Skill Basis from the drop-down menu: (None), Duty, Task or Subtask.

Step 6 If Duty, Task, or Subtask was selected, click on the drop-down arrow in the adjacent field and select the appropriate item for the Duty, Task, or Subtask. If the menu is blank, there are no items of this type linked to the Performance Requirements selected, in which case you can select the (None item for the Skill Basis).

Step 7 If Suggest a new Subtask was selected, click on the drop-down arrow to select the Attribute: Ability, Knowledge, Resource, Skill, or Tool.

Step 8 If an Attribute was selected click on the drop-down arrow in the adjacent field and select the applicable attribute.

Step 9 Click on the Save button to save the new Lesson information.

**NOTE:**
If a Skill Basis was selected, when you save you will be given the option to use the linked JDTA item (for example Task) as the default wording for the learning objective. You will be able to edit the learning objective.

Step 10 Click on the ISD Considerations link.

Step 11 Click the Edit button to add information for the appropriate ISD Considerations for the Lesson. Refer to Figure 6-19.
Step 12 Click on the Save button to save your Lesson.

To develop a Terminal Objective Statement (TOS) for the Lesson:

Step 1 Click on the Lesson title in the COI tree structure.

Step 2 Click on Objective. The Objective development window will open. Refer to Figure 6-20

Step 3 In the Select Type field click on the drop-down arrow and select the desired type of entry to begin developing your objective. One or more of the double asterisk items must be selected, single asterisk items of a type are mandatory, and the remaining types are optional to make an objective complete.

Step 4 Repeat Step 3 until you have all the types desired.

Step 5 Click on the Save button to save your selections.
NOTE:
You can also choose the "Search Objectives" link to find an existing objective to use or edit.

Step 6 To Re-sequence the types of your objective click on the Resequence Items link. Drag and drop orange boxes to the location desired. Click on the Save button to save the new sequence.

Step 7 To delete a selected type, highlight the item and click on the Delete button adjacent to it. Click on the Save button to complete your deletion.

6.3.2.4 Adding a Section to a Lesson

Sections can be created from Tasks, Subtasks, or Steps contained in the database for the Performance Requirements selected. If no data is present in the database for the Section being developed you can leave the Skill Basis blank.

To add a Section to a Lesson:

Step 1 Click on the desired Lesson of your course in the COI tree structure.

Step 2 Click on the New icon.

Step 3 Enter the title of the Section in the Section Title field.

Step 4 Enter the time in minutes of how long it will take the student to complete the Section in the Length field.

Step 5 Select the delivery method from the drop-down menu: Self Paced, Instructor Led, Blended, Lab, or EPSS.

Step 6 In the Content Type field click on the drop-down arrow and select the type of objective you will develop: Concept, Fact, Principle, Procedure, or Process.

A Section is referred to as a “topic” within the Lesson. The Section content (elements) varies depending on the type of Section selected.
There are five types of Sections:

- **Concept** – A class of items that shares common key features and is known by a common name.
- **Fact** – Unique, one-of-a-kind types of information.
- **Process** – A series of actions, changes, or functions that achieve an end result. It often is used when you need to illustrate a flow of events that describes how something works.
- **Procedure** – A sequential set of steps to be followed by one individual to accomplish a task or make decisions. Actions within the procedure must be done the same way each time within a given situation.
- **Principle** – A procedural job task that requires judgment or when guidelines must be applied to a situation.

**NOTE:** If in doubt about the type refer to the Navy ILE web site [https://www.netc.navy.mil/ile/](https://www.netc.navy.mil/ile/), select the tab for Policy and Guidance and refer to **Navy ILE Instructional Content Style Guide: Interactive Multimedia Instruction & Instructor-Led Training**, document, paragraph 1.5 Content Types.

---

**Step 7** Select the Cognitive Level from the drop-down menu: Apply or Remember.

**Step 8** Select the Skill Basis from the drop-down menu: (None), Duty, Task or Subtask.

**Step 9** If Task, Subtask or Step was selected, click on the drop-down arrow in the adjacent field and select the appropriate item for the Task, Subtask, or Step.

If the menu is blank, there are no items of this type linked to the Performance Requirements selected, in which case you can select the (None item for the Skill Basis).

**Step 10** If the Task, Subtask, or Step was selected, click on the drop-down arrow to select the Attribute: Ability, Knowledge, Resource, Skill, or Tool.

**Step 11** If an Attribute was selected click on the drop-down arrow in the adjacent field and select the applicable attribute.

**Step 12** Click on the Save button to save your Section.

**NOTE:**

If a Skill Basis was selected, when saving the option to use the linked JDTA item (for example Task) as the default wording for the learning objective will be available. Editing the objective will still be available.

**Step 13** Click on the [ISD Considerations](#) link.
Step 14 Click on the Edit button to input the desired ISD Considerations. Refer to Figure 6-21.

![ISD Considerations Window](image)

**Figure 6-21. ISD Considerations Window**

To develop an Enabling Objective Statement (EOS) for the Section:

Step 1 Click on the Section title in the COI tree structure.

Step 2 Click on **Objective**. The Objective development window will open.

Step 3 In the Select Type field click on the drop-down arrow and select the desired type of entry to begin developing your objective. One or more of the double asterisk items must be selected, single asterisk items of a type are mandatory, and the remaining types are optional to make an objective complete.

Step 4 Repeat Step 3 until you have all the types desired.

Step 5 Click on the Save button to save your selections.

Step 6 To Re-sequence the types of your objective click on the **Resequence Items** link. Drag and drop orange boxes to the location desired. Click on the Save button to save the new sequence.

Step 7 To delete a selected type, highlight the item and click on the Delete button adjacent to it. Click on the Save button to complete the deletion.

6.4 **REPORTS**

There are five reports that the CPM software will compile and display in a PDF file:

- Training Project Plan
- Curriculum Outline of Instruction
- IMDP
- Training Course Control Document
- Skill Basis
(This Page Intentionally Left Blank)
7.0 REPORTS

The Reports tab provides an area where you can print several types of reports for your Center. Refer to Figures 7-1

Highlight the desired report name and click on the print icon. The software will create the report for your Center and it will open in Adobe. You can save/print it from Adobe.
CHAPTER 8

RESOURCES

8.0 RESOURCES .......................................................... 8-1
8.0 RESOURCES

The Resources tab provides an area where you can view, add and edit resources for your Center. *Refer to Figure 8-1*

**To add a new resource:**

**Step 1** Click on the desired resource category. *Refer to Figure 8-1.*

**Step 2** Click on the New icon to add a new resource. *Refer to Figure 8-2.*
Step 3 Enter the required information for the CPM software, identified by an asterisk next to the field. Identify other information if necessary.

Step 4 Click on the Save button to save your entry to the database.

The software will provide fields for identification information for each type of Resource as follows:

All equipment related categories ask for the same information as identified in Figure 8-3. The following categories are equipment related:

- Calibration
- Computers
- Consumables
- Equipment
- Hand Tools
- Maintenance Trainers
- Miscellaneous Materials
- Ordnance
- Prefaulted Modules
- Refurbishments
- Special Tools
- Support Equipment
- Test Equipment
- Test Equipment
- Trainer Materials
- Training Devices
- Training Equipment
Equipment related categories provide fields to identify the following information:

- Part Number
- Nomenclature
- Source
- AAC - Acquisition Advice Code
- Unit Cost
- Unit of Issue
- CAGE - Commercial and Government Entity
- Technical Reference
- SM&R - Source Maintainability and Recoverability
- COG - Cognizant (activity)
- SMIC - Special Material Identification Code
- NINN/NSN – Stock Number
- MACOCO - Manufacturing Cost Code

Photographs and Wall Charts contain fields to identify Number, Title, Source, and Figure Number. Refer to figure 8-4.

Films and Videos contain fields to identify Number, Title, Running Time, and Source. Refer to figure 8-5.
IETM (Interactive Electronic Technical Manual) and Publications contain fields to identify Number, Title and Source. Refer to figure 8-6.

IMI (Interactive Multimedia Instruction), Slides, and Transparencies contain fields to identify Number, Title, Source, and Description. Refer to figure 8-7.
Software contains the following fields: *Refer to figure 8-8.*

- Number
- Type
- Vendor
- Software type
- Cost
- Version
- Date
- Reference Information
- Contact Information
- Minimum System Requirements

---

**Figure 8-7: Adding an IMI**

**Figure 8-8: Adding Software**
9.0  ADMIN

The Admin tab provides an area where the System and Center Administrators can add and edit CPM User information, identify User and Project Roles, identify Centers, edit TTA Data and create, edit, print and delete announcements.

9.0.1  Gatekeeper

Gatekeeper functionality has been incorporated into CPM to reduce redundancy and standardize data elements. Currently Gatekeeper functions are being performed by NETC and AIM personnel, eventually this will shift to Center Administrators.

Gatekeeper functionality requires a role with "Administer" privilege for both the Data and Resources tabs.

Gatekeeper functionality includes the following:

- Linked Items Report
- Unlinked Items Report
- Similar Items List
- Replace Function

The Linked Items Report will list all Centers linked to an item in the Data and Resources tabs. The Unlinked Items Report will list all items in the Data and Resources tabs not currently linked to a JDTA or an Objective in the Curriculum Outline of Instruction. Both reports will list the following information:

- Type
- Item
- Date
- Center (if linked to a center)

The Similar Items List is used to check for possible duplicate entries, and the Replace Function is used to eliminate those duplicates.

9.1  Users

When the Admin tab is selected the Users menu item is selected by default. The window opens to reveal information about Active, Pending, Inactive, and Currently Logged in Users can be selected by clicking on the down arrow and selecting the desired users.
9.1.1 Active Users

The Active Users menu provides an area where the Administrator can add New users and Deactivate users. Refer to figure 9-1.
To add a New User:

Step 1  Click on the Add icon. *Refer to Figure 9-2.*

![Figure 9-2 Adding User]

Step 2  Enter the required information in the fields marked by an asterisk*.

Step 3  Click on the Save button.

To Change a Password for a User:

Step 1  Click on the user in the Active Users list.

Step 2  Click on the Edit button.

Step 3  Click on the Change Password button.

Step 4  Enter the new password in the Password field.

Step 5  Enter the password again in the Verify Password field.

Step 6  Click on the Save button.

To Deactivate a User:

Step 1  Highlight the user.

Step 2  Click on the Deactivate icon.

Step 3  When prompted “Are you sure you want to deactivate this user?” click on OK.
9.1.2 Pending Users

Pending Users originate from users that request an account from the login window of the CPM. When the user submits the information an Email is automatically sent to their Email address from the System Administrator stating “This is to verify your CPM account request has been submitted at https://navyile.fedsun.navy.mil/CPM. You should be receiving an email within the next couple of days with a status of your request. Please feel free to contact me with any questions you may have about this request.

To change a password for a Pending User:

Step 1 Click on the user in the Pending Users list.
Step 2 Enter the new password in the Password field.
Step 3 Enter the password again in the Verify Password field.
Step 4 Click on the Save button.

To Accept a Pending User:

Step 1 Click on the user in the Pending Users list.
Step 2 Click on the Accept button. This will place the User in the Active Users list. An Email will be sent to the user automatically from the System Administrator with login, password and other amplifying information.

To Reject a Pending User:

Step 1 Click on the user in the Pending Users list.
Step 2 Click on the Reject button.
Step 3 At the prompt “Are you sure you want to delete this user?” click on OK.

9.1.3 Inactive Users

To Delete an Inactive User:

Step 1 Click on the user in the Inactive Users list.
Step 2 Click on the Delete icon.
Step 3  At the prompt “Are you sure you want to delete this user?” click on OK.

To Activate an Inactive User:

Step 1  Click on the user in the Inactive Users list.

Step 2  Click on the Activate icon.

Step 3  At the prompt “are you sure you want to Activate this user?” click on OK.

To Change a Password for an Inactive User:

Step 1  Click on the user in the Inactive Users list.

Step 2  Click on the Change Password button.

Step 3  Enter the new password in the Password field.

Step 4  Enter the password again in the Verify Password field.

Step 5  Click on the Save button.

9.1.4 Currently Logged in Users

A list of users that are currently logged into the CPM will appear when the Currently Logged in Users menu item is selected.

9.2 ROLES

The purpose of the Roles menu item is to add and define the User Role nomenclature, level of access to Data, OCCSTDs, JDTA, Projects, Resources, and Reports and to identify Leaders of Projects and types of Administrators. You can also identify, add, and define Project Roles.
9.2.1 User Roles

To add a new user role:

Step 1 Select User Roles.

Step 2 Click on the New icon.

Step 3 Enter the Role Title in the field provided.

Step 4 In the Data, OCCSTDs, JDTA, Projects, Reports and Resources fields, from the drop-down menu in each field, select None, View, Edit, or Administer.

Step 5 In the Administration field, from the drop-down menu, select None, Center Administrator, or System Administrator.

Step 6 Click on the Save button to save the User Role.

9.2.2 Project Roles

To add a new project role:

Step 1 Select Project Roles.

Step 2 Click on the New icon.
Step 3 Enter the Role Title in the field provided.

Step 4 In the remaining fields, from the drop-down menu in each field, select View, Edit, or Administer for:
- Project Data
- Team Members
- Performance Requirements
- TPP/TCCD
- Assignments
- Curriculum Outline of Instruction

Step 5 Click on the Save button to save the Project Role.

9.3 CENTERS

The Centers menu item provides an area where the Administrator can create, edit, and delete Centers identified in the database. Refer to Figure 9-5.

To add a New Center:

Step 1 Select the Centers menu item.

Step 2 Click on the New icon.

Step 3 Enter the Name of the Center in the field provided.

Step 4 Click on the Save button to save your entry to the database.
To delete a Center:

Step 1 Select the Centers menu item.

Step 2 Click on the Center to be deleted.

NOTE: A Center cannot be deleted if Users or Occupations are assigned to the Center.

Step 3 Click on the Delete icon.

Step 4 At the prompt “Are you sure you want to delete this Center?” click on the OK button.

9.4 AGENCIES

The Agencies menu item provides an area where the Administrator can create, edit, and delete an Agency identified in the database. Refer to Figure 9-6.

To add a New Agency:

Step 1 Select the Agencies menu item.

Step 2 Click on the New icon.

Step 3 Enter the Name and Address of the Agency in the fields provided.

Step 4 Click on the Save button to save your entry to the database.

To delete an Agency:

Step 1 Select the Agencies menu item.

Step 2 Click on the Agency to be deleted.
Step 3  Click on the Delete icon.

Step 4  At the prompt “Are you sure you want to delete this Agency?” click on the OK button.

9.5 TRAINING SITES

The Training Sites menu item provides an area where the Administrator can create, edit, and delete a Training Site identified in the database. Refer to Figure 9-7

![Figure 9-7: Training Sites](image)

To add a New Training Site:

Step 1  Select the Training Sites menu item.

Step 2  Click on the New icon.

Step 3  Enter the Name and Address of the Training Site in the field provided.

Step 4  Select the associated Center from the drop-down menu.

Step 5  Click on the Save button to save your entry to the database.

To delete a Training Site:

Step 1  Select the Training Sites menu item.

Step 2  Click on the Training Site to be deleted.

Step 3  Click on the Delete icon.

Step 4  At the prompt “Are you sure you want to delete this Training Site?” click on the OK button.
### 9.6 TRAINING TASK ANALYSIS (TTA) DATA

The TTA menu item provides an area where the Administrator can create descriptive statements for task identification. The analysis data is comprised of the following items: Refer to Figure 9-8.

- Safety Hazard Security
- Criticality of Performance
- Task Delay tolerance
- Frequency of Performance
- Probability of Inadequate Performance
- Difficulty of Performance
- Task Learning Difficulty
- Percent Performing
- Percent of Time Spent on Performing
- Immediacy of Performance
- Intervention
- Task Level
- Status of Training
- Type of Training

![Figure 9-8: TTA](image)

**To add a New descriptive statement for a TTA item:**

1. Step 1 Select the TTA menu item.
2. Step 2 From the drop down menu select the desired TTA item.
3. Step 3 Enter the text of the descriptor in the Name field provided.
4. Step 4 Enter the Sequence number if different from the default.
5. Step 4 Click on the Save button to save your entry to the database.

**To delete a descriptor from a TTA item:**

1. Step 1 Select the TTA menu item.
Step 2 From the drop down menu select the desired TTA item.

Step 3 Click on the descriptor to be deleted.

Step 4 Click on the Delete icon.

Step 5 At the prompt “Are you sure you want to delete this item?” click on the OK button.

9.7 In-Use

The In-Use tab is used to clear In-Use flags that have been generated erroneously. To remove the In-Use flag, follow the steps below:

Step 1 Click on the In-Use element you wish to remove.

Step 2 Click on the Delete icon. *Refer to Figure 9-9.*

Step 3 Confirm the deletion of the In-Use flag.

![Figure 9-9: In-Use Flag Removal](image)
9.8 ANNOUNCEMENTS

The Announcements menu item provides an area where the Administrator can create, edit, and delete System Announcements that are displayed on the CPM User’s Homepage. Refer to Figure 9-10.

![Figure 9-10: System Announcements](image)

**To create a System Announcement:**

1. **Step 1** Click on the Admin tab.
2. **Step 2** Click on the Announcements menu item.
3. **Step 3** The two icons in the Announcements pane are New and Delete. Click on the New icon.
4. **Step 4** Click on the calendar icon and select the Expiration Date.
5. **Step 5** Enter the subject text in the Subject field.
6. **Step 6** Enter the announcement information in the Content field.
7. **Step 7** Click on the Save button when complete.

After the Announcement is saved you can edit it by clicking on the announcement in the left hand pane. This will open the Announcement in the right hand pane and it is editable.

An Announcement can be deleted by clicking on the announcement no longer required and clicking on the Delete icon. When prompted with “Are you sure you want to delete this announcement?” click on OK.